PIVOT TABLE

Pivot Table is a great tool for summarizing and analyzing data in Excel.

We can use a Pivot Table to perform calculations on our data based on certain criteria. For
example - Sales per Store, Sales per Year, Average Discount per Region, and many more...
Here are some of the advantages of using Pivot Tables:

e There is no need to use formulas in order to perform calculations.

e We can perform complex calculations in a quick and simple way.

e The summarized data is dynamic and can easily be applied to different sets of data

Creating a Pivot Table

To create a new Pivot Table, we first need to select the data range which we would like to
analyze, then click on one of the desired cells in our data range, then click Insert tab, then
Pivot Table.

Let’s assume we want to analyze a database of cars sold by a car vendor:

. A B | ¢ | b | E | F | G | H [ )|
1 |Car Model * Year |~ Hand ~ | Colour| = Gear ~ |Agency |~ TagPrice ~ |Final Price| = Arrival Date - Sale Date -
2 |Toyota Yaris 2015 3 Yellow  Automatic London 9500 9400  25/04/2017 04/05/2017
3 IMinI' Cooper 2017 2 Blue Manual Birmingham 21000 19500 25/10/2017 26/10/2018
4 |HyundaiSonata 2018 4 Black Manual Birmingham 9700 9600  26/02/2018 18/11/2018
5 |Ford Edge 2018 2 Blue Manual Manchester 22000 18600 13/12/2018 02/02/2019
6 |Hyundai i25 2017 1 Red Manual  Liverpool 14500 12100 04/05/2017] 30/01/2018
7 |HyundaiSonata 2015 1 Yellow  Automatic Manchester 9700 9200  20/02/2018 12/03/2018
8 |Mini Cooper 2017 2 Yellow  Manual Birmingham 21000 20300  25/09/2017 12/10/2017
9 |Ford Edge 2018 2 Blue Manual Manchester 22000 21100  03/12/2018 03/03/2019
10 | Hyundai i25 2018 2 Blue Manual London 14500 12000  02/05/2017 12/06/2017
11 HyundaiSonata 2017 3 Black Manual London 9700 8600  24/01/2018 16/02/2018
12 IMini Cooper 2015 4 Black Manual Manchester 21000 18700 06/10/2017 06/11/2017
13 _Hyundai i25 2017 1 Red Manual Liverpool 14500 12400 08/05/2017 06/08/2017
14 Hyundai Sonata 2018 1 Red Automatic Londen 9700 9500  02/02/2018 13/05/2018
15 _Hyundai i25 2018 2 Red Manual London 14500 14400 20/04/2017 09/06/2017
16

To create a new Pivot Table:
A. We will click on one of the cells in the data range.
B. We will go to the Insert tab and click on Pivot Table:
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C. Next, we will confirm that the selected range is indeed the right range.



Create PivotTable ? X

Choose the data that you want to analyze
(@ Select a table or range
Table/Range: DatalSAS1:SJ56 [2]
O Use an external data source

Choose Connection..,

Connection name:
Use this workbook’s Data Model
Choose where you want the PivotTable report to be placed
@ New Worksheet
(O pisting Worksheet

Location: ; E_]

Choose whether you want to analyze multiple tables
I:] Add this data to the Data Model

OK Cancel

A

4. Last, we will select “New Worksheet” to create the Pivot Table in a new worksheet, or
“Exisiting Worksheet”, to place it in an existing worksheet.

After we decided to create a Pivot Table, we can see all the column headers - these are the
fields from our database which we can work with:

PivotTable Fields ~ %
Choose fields to add to report: &~
:Search D

[ car Model =
[ vear

[ Hand

[ colour

[ Gear

(] Agency

Od Tag Price

[ Final Price -

Drag fields between areas below:

Y Filters Il Columns

Rows Z Values

Defer Layout Update



To start creating our Pivot Table, we can drag the different fields to the following areas:
e Rows - Here we will choose the field/s which we would like to base our Pivot Table rows

upon.

e Columns - Here we will choose the field/s which we would like to base our Pivot Table

columns upon.

o Filters - Here we will choose the field/s by which we would like to filter our data in the

Pivot

i.e.- we would choose “Year” to filter by a specific year.

calculation.

Creating a basic Pivot Table - Example

Table.

Values - Here we will choose the field we want Excel to calculate and our desired

One of the most basic examples of using a Pivot Table is summing values of a specific field
based on a criteria that appears in a different field.

In order to do so, we will drag the field which we would like to analyze into the “Rows” area
or “Columns” if we would like to present the analysis in columns. We will the drag the field
we want to sum into the “Values” area:

PivotTable Fields ~ X

Choase fields to add to report: -

Search jo

[ car Model -
[ vear
[J Hand

[ colour

[J Gear

DAgeﬂc‘,-

O Tag Price

[ Final Price -

Drag fields between areas below:

Y Filters Il Columns
= Rows Z Values
Car Model v Sum of Final P... =

Defer Layout Update

Changing the way Values are calculated

"

Row Labels |~ _|Sum of Final Price

Ford Edge 39700
Hyundai i25 50900
Hyundai Sonata 36900
Mini Cooper 58500
Toyota Yaris 9400
Grand Total 195400

We will notice that most times, the basic calculation we will get when dragging a field to the

“Values” area will be “Sum”.

We can change the calculation by clicking the field after we dragged it into the “Values” area,
then “Value Field Settings...”, which will open a menu where we can choose to sum, count,
average and many more calculations:



, Value il Setings ’ Row Labels ~ |Count of Final Price
Source Name:  Final Price
: Sotom Name: | Count of Fnal Price Ford Edge 2
|. e Hyundai i25 4
1T Move to Report Filter o calolation Bt you wast b3 i 1o SummIrDe 1 H
o Mo o R Laber ’ PR Hyundai Sonata 4
- =
Move to Cokme Labe E—— ini
I ove to Calumn Labeels — Mlﬂl Cooper 3
R Il
2 e . Toyota Yaris 1
I.i_',-J Value Field Setti e =] o Grand Total 14
T

Segmentation to Columns and Rows

We can segment the data using rows and columns simultaneously by dragging fields to the
“Rows” and “Columns” areas:

Drag fields between areas below:

Y Filters Il Columns
Agency T Sum of Final Price -|Column Labels ~
'Row Labels - Birmingham Liverpool London Manchester Grand Total
_Ford Edge 39700 39700
= Rows 3 Values . |Hyundai 25 24500 26400 50900
5 |Hyundai Sonata 9600 18100 9200 36900
CarModel ~ i SumofFinal P-. |Mini Cooper 39800 18700 58500
| Toyota Yaris 9400 2400
'Grand Total 49400 24500 53900 67600 195400

Defer Layout Update

Performing multiple calculations on the same field

We can perform a number of different calculations on the same field by dragging the field
several times to the “Values” area and changing the type of calculation in each of the columns:

Agency

Drag fields between areas below: Uo
Tag Pric .

Y Filters I Columns % Final Pt
3 . v\ Segnn Row Labels - Sum of Final Price Count of Final Price

- Values Irag field:
1 43200 4
¥ Filtes Y Mo 2 105900 6
‘ 18000 2
™ Rows I Values 28300 2
Hand v Sum of Final P... ¥ 195400 14

Count of Final.. ¥

Segmentation of more than one field

In the Pivot Table, we can segment based on more than one field by dragging several fields

into the “Rows” area:



Drag fields between areas below:

T Filters B Coalumns
= Rows E Values
Agency b Count of Final.. ~
Gear '

Designing a Pivot Table

N

Row Labels -~ Count of Final Price

| = Birmingham
Manual

| = Liverpool
Manual

| = London
Automatic
Manual

| E Manchester
Automatic
Manual

Grand Total

Changing the Pivot Table design to a classic table design
In order to give the Pivot Table a “classic” look, where each field is presented in a different
column, we will click the Pivot table, click on “design” and perform the following steps:

1. Click on Report Layout

2. Click on “Show in Tabular Form” to show the table in a classic format
3. Click on “Repeat All Items Labels” to show all item labels.
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4. We can click on “Do Not Show Subtotals” to hide the subtotals in the newly created table.

This is the process and final result:

‘Ruw Labels | - Count of Final Price
| =Birmingham
Manual
| Liverpeol
Manual
= London
Automatic
Manual
= Manchester
Automatic
Manual
|Grand Total
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Formatting a Pivot Table field

PivotTable Tools

View Analyze Design

i = feflial] |
: -E

Agency - |ear | - cCount of Final Price

= Birmingham Manual

= Liverpool  Manual

=London Automatic
London Manual

=Manchester Automatic

W W NN W

Manchester Manual
Grand Total 1

We can quickly select the way we wish to format a certain value field, by right-clicking the
field and then clicking on “Format Cells”, or directly on “Number Format”, if we wish to
format the values as number and add 1000 separator (4,524,254 instead of 4524254):



2369
2337 B
835
1315 [
1674
1591
995
1044
1532
2115
2368
1465
1379
1828 73
1835
1914,
2608 I

Copy

Format Cells..
Number Format...
Refresh

Sort

Remove "Sum of "M2n ynn
Summarize Values By
Show Values As

Show Details

Value Field Settings...
PivotTable Qptions...

Hide Field List

Designing missing values and errors

Format Cells ? X

Number
Category:

| General Sample

pustes 835,813

Currency -~

Accounting tacias S

Date Decimal places: 0 <

Time [AUse 1000 Separator ()]

Percentage

Fraction Negative numbers:

Sdentinic
yeit 1,234

Special 11,234

Custom

0,234

Number is used for general display of numbers. Currency and Accounting offer specialized
formatting for monetary value.

We can control the way missing values (empty cells) or errors are presented in the Pivot
Table by right-clicking one of the cells and clicking on “Pivot Table Options”, then ticking “For
error values shows” or “For empty cells show” (as shown in the following example)

Sum of Final Price |Gear W

Colour v ic Manual  Grand Total
Yellow 18600 20300 38900
Red 9500 38900 48400
Blue 71200 71200
Black 36900 36900
Grand Total 28100 167300 195400

Filtering a Pivot Table

»

PivotTable Options

PivotTable Name: PivotTableS

layout & Format  Totals & Filters  Display  Printing  Data

Layout

Dlegeand center cells with labels
When in compact form indent row labels: | 1

? X

Sum of Final Price Gear 5
Colour -l ic Manual  Grand Total
ARiTen Yellow 18600 20300 38900
’ Red 9500 38900 48400
Blue 0 71200 71200
S character(s) Black 0 36900 36900
Grand Total 28100 167300 195400

Display fields in report filter area: Down, Then Over |~

Report filter fields per column: |0

Format

[ For error values show:

[ For empty cells show:

Filtering existing fields in a Pivot Table
We can filter data shown in the Pivot Table rows simply by clicking the corresponding button

in the desired field. For example, to filter the “Gear” field, we simply have to click the button
next to the field name:

Agency * Gear

= Birmingham Manual
| = Liverpool Manual
| = London Automatic

London Manual

. = Manchester Automatic
. Manchester Manual
Grand Total

* Bum of Final Price

49400
24500
18900
35000
9200
52400
195400



Filtering values in a Pivot Table

What if we wanted to filter the values in our Pivot Table?

To do so, we can start our filtering by clicking the filter button in one of the fields, then click
on “Value Filters”, following which we will be able to see the various value filtering options.
Here’s an example of how to filter values greater than 40,000:

= = TRy x Colour |7 Sum of Final Price
Colour | | ~ \Sum of Final Price s
Black 36900 » R = = g | » Blue 71200

o of it Brice s gestae ran i Red 28200

Blue 71200 ) — i
Red 48400 e . o [ cma || Grand Total 119600
Yellow 38900 - 8| e .
Grand Total 195400 s —

Adding an external filter to a Pivot Table

If we want to filter based on a field that is not currently in the Pivot Table, we could drag that
field into the “Filters” area:

Drag fields between areas below:

Y Filters Il Columns SEcncy (All) -
Agency bd . .

Colour |~! Sum of Final Price

» Yellow 38900

Red 48400

= Rows 2 Values Blue 71200

o ot Black 36900

oieur dmorTinat . Grand Total 195400

Please note - we can add more than one field to the “Filters” area.

Sorting values in a Pivot Table

If we want to sort our fields, we just have to right-click on the desired field and click on “Sort”:




Updating and refreshing the Pivot Table data

After updating the source data, we have to refresh the Pivot Table in order for the new
data to be reflected in the Pivot Table. We can do that by right-clicking the table and clicking
on “Refresh” or by Refresh/Refresh all in the “Data” group

Adding new data at the end of the data range

[f we want to add new data to our Pivot Table that will be added at the end of the previously
used data range, we need to update the source data’s range by clicking on “Change Data
Source” in the “Data” group:

Pivot Tables - Excel

Design Q Tell me what you want to do

= & S (AR iE
¥ =y 3 Lol g |
Insert  Insert Refresh\Change Data | Clear
Slicer Timeline v Source ~ v

Filter

Another way of dealing with this issue is by adding the new data in the middle of the
previously used data range and then refreshing.
Automatically update Data Source Range when adding new rows by using Tables

Another way to save time if we are planning to update the data source range often is changing
the data source range to a table by clicking in “Table” in the “Insert” tab or by clicking CTRL+T

File Home Insert page Lay Car Model - Year - Hlnd- Cobur. Gear - Agency . Tag Priu. Final Pria. Arrival Da!-. Sale Date 4
= Toyota Yaris 2015 3 Yellow  Automatic London 9500 9400  25/04/2017 04/05/2017

o =] 4 Mini Cooper 2017 2 Blue Manual Birmingham 21000 19500  25/10/2017 26/10/2018

[] ? @ E ‘ Hyundai Sonata 2018 4 Black Manual Birmingham 9700 9600  26/02/2018 18/11/2018
PivotTable Recomm;nd A Table Pictur Ford Edge 2018 2 Blue Manual  Manchester 22000 18600  13/12/2018 02/02/2019
3 Hyundai i25 2017 1 Red Manual Liverpool 14500 12100  04/05/2017 30/01/2018

PivotTables Huindai Sonata  IMS 1 Vellow  Automatic Manchacter Q700 @nn  20/mHMR 12/0/MR

Now we can create/update the Pivot Table that will use the table as the source data, and
when the table will be updated- the Pivot Table’s source data range will be updated as well.
Here’s how our Data Source looks like:

Create PivotTable ? X

Choose the data that you want to analyze

@ Select a table or range

I=»

Table/Range: Tabledl

O Use an external data source




Show Values As

We can present the calculated values in the “Values” area in different ways, i.e. a percentage
of total, by clicking the desired value in the “Values” area, then clicking on “Value Field

Settings” and then on “Show Value As”:

Agency E Sum of Final Price

Birmingham 49400
Liverpool 44100
London 53900
Manchester 67600
Grand Total 215000

Y Move to Report Filter
= Move to Row Labels

Il Move to Column Labels

X Remove Field

L_$ Value Field Settings...

e _

Saurce Mame: Final Price

Qustom Mame: | Sum of Final Price
Summarize Vales By Show Values 4s
Show values az

% of Grand Total

s o =1

Presenting a breakdown of a value in a Pivot Table

Base item:

Agency |Z| Sum of Final Price

Birmingham 22.98%
Liverpool 20.51%
London 25.07%
Manchester 31.44%
Grand Total 100.00%

Whenever we like, we can present all the items that are calculated in a certain cell in the
Pivot Table by double-clicking that cell. This will result in a new sheet opening:

|Sum of Final Price Gear Iz‘

Colour Grand Total Car Model. Year - Hand [d Colour - Gear | Agencv- Tag Price- Final Price- Arrival Date- Sale Date-
_VEIIow 18600 20300 38900 Hyundai i25 2| Blue Manual 12000 02/05/2017 12/06/2017
|Red 9500 38900 42400 Mini Cooper 2| Blue Manual 19500  25/10/2017 26/10/2018
7B|uE 0 71200 ’ Ford Edge 2| Blue Manual 21100 03/12/2018 03/03/2019

Black 0 365800 36900 Ford Edge 2| Blue Manual 18600  13/12/2018 02/02/2019,
_/Grand Total 28100 167300 195400
Grouping Data

We can group data presented in the Pivot Table’s rows
reverse it with “Ungroup” by right-clicking one of the cells:

Arrival Date - Count of Gear
20/04/2017
25/04/2017

| o02/05/2017
04/05/2017
08/05/2017
25/09/2017
06/10/2017
25/10/2017
24/01/2018
02/02/2018
20/02/2018
26/02/2018
03/12/2018

| 13/12/2018

Grand Total

i e i e e e e

=
'y

Date data will usually be grouped automatically to months/years
We can also group numerical data (i.e 1-100, 101-200, etc.)

2

2a/01/20%0 ’

02f02/2¢ 0 Lopy
20/02/2( [E Format Cells...
26/02/2( 2,

&4 Refresh
03/12/2(
13/12/20
Grand Total Filter >

Subtotal “Arival Date®
Expand/Collapse
i Group-
%8 Ungroup..
Move
X Remaye "Arrival Date”
Fo Field Settings...
PivotTable Options..

S
Bl wide Field List

Grouping

Auto

Starting at: | 20/04/2017
Endingat: | 14/12/2018

By

and columns with “Group” and

Arrival Date IE‘ Count of Gear
Se.mnds 2017 8
Minutes
Hours 2018 6
D
eMZ’:ms Grand Total 14
| Quarters

Mumber of days:




Creating Pivot Charts

We can add charts to existing Pivot Tables or create new charts based on a new Pivot Table.
Sum of Final Price

TOTAL

Hand ~
w1
w2

u3

o Existing Pivot Table - We will click on the “Analyze” tab and then on “Pivot Chart” in the
“Tools” group (we have to select a cell in the Pivot Table before doing this)

o Creating a new Pivot Table - “Insert” tab -> “Pivot Chart” in the “Charts” group (we have
to select the desired source data before doing this)

When we click on the Pivot Chart, the names of the categories will look like this:

Drag fields between areas below: Sum of Final Frice
0000
T Filters I Legend (Series) —
Car Model ¥ 50000 . Car Model -
SO000 Ford Edge
0000 Hyundal 25
[T . T va 20000 — Hyundal Sonata
is (Categori—. alues
20000 Mini Cooper
Years - Surmn of Final P.. =
U ! B— Toyota Yaris
Quarters B 5
Sale Date r 2017 018 2019
Years ¥ Quarters * Sale Date = + =

Like any other chart, we can control the axis’ directions and the chart type by clicking on the
“Design” tab. We can, for example, replace the X and Y axis by “Switch Row/Column” in the
“Design tab”. We can also change the Chart type:

Macros  Anahze  Design  Format



Adding Slicers / Timelines to a Pivot Table

Adding Slicers to a Pivot Table
e We can add Slicers to our Pivot Table / Chart, which will enable visually filtering the field,
by clicking on the “Analyze” tab and then on “Insert Slicer”. Here’s how it looks:

Insert Slicers ? % Sum of Finsl Price. Gear = %
TR Ausiomatic
BOOD i
Manual
[] car Model — b =
D Year fr— o1l g
20000 \x — e 0%
|:| Hand — ——byundai Sorata
0 -
S M Cooper
D Colour 10000
L]
E Gear 207 FLTY 19
DAQQ“W Vibid * Chaitis * Salh Dale * b
Sum of Final Price Colour = % Agency = || vear = T
BOND | Bilack Birvmngham 2015
000 | Bl Liverpood 2016
BO000 [ Car Modsl -
w0000 e 3118 50 | — London e
_— iyl 5 | Yellow Manchester 2018
— = Hyuratal Sonate
_— M Copper
Lo Tioyots Yaris
0
2017 o] 20189
Yams v (uaries * Sak Daw L=

e We can select several values in the Slicer by using CTRL/ SHIFT.
e To cancel the filtering of a Slicer, we will click on this button at the top of the Slicer:

Adding a Timeline to a Pivot Table

For date fields, we can add a Timeline by clicking on the “Analyze” tab and then on “Insert
Timeline”:

Sale Date T
2017 YEARS -
2017 2018 2019
—
1 >




Pivot Table Calculated Fields

We can perform calculations within the Pivot Table itself, Instead of creating calculation
columns in the source data. For that, we can use a “Calculated Field”.
A Calculated Field is calculated based on the sum of a certain field.

We will add a Calculated field by clicking on:

Analyze tab -> Fields, Items & Sets -> Insert Calculated Fields:

Analyze  Design £ Tellm

S |BiEs O =

Yowe Fields, lems, Relation
itTable B Sets -
Calculated Field...

We will name each Calculated Field and write the desired formula for it (you can insert the
desired field by double-clicking it).

Here’s an example of calculating the Sales amount after a 2% commission:

L] Tag Price
Insert Calculated Field ? X 7 Final Price
[ Arrival Date
Name: Sales after commission w Add O sa
Formula:  =0.98" ‘Final Price’ Delete etéﬂeii
ears
. Sales after commissios
Fields: =~ ‘Row Labels - Sum of Final Price Sum of Sales after
Sﬂ' Model A Drag fields between areas below: Birmingham 121900 119462
ear
Hand . T Filters W Columns ‘ Liverpool 128800 126224
s
ol % Vawes London 106000 103880
i Manchester 117000 114660
R — | Grand Total 473700 464226
Agency i Sum of Final P ¥
(¢12 oty Sum of Sales .~




